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Chapter 1: About this Users Guide
Welcome!

Welcome to StuffIt Deluxe 8.0! For general information about StuffIt
Deluxe, including System Requirements, Installation instructions, and a list
of new features, please read the StuffIt Deluxe Quick Start Guide.

Using the
included
documentation

StuffIt Deluxe now includes HTML based AppleHelp for many of its
components. AppleHelp is available for StuffIt Expander, DropStuff,
Magic Menu, and Archive Assistant. You can access AppleHelp, while
running the applications, by clicking the Help menu.

What to do if you
need Help

If you need help using StuffIt Deluxe, Allume’s online site provides a
constantly updated system of FAQ's (Frequently Asked Questions). The
chances are that someone else has already reported the same issue, and
we've posted information about it. Our new and improved Support site
offers an easy three-step process for finding all the FAQ's related to your
version of the software Or if you prefer, use the new intuitive search
engine, which allows you to search all the FAQ's and then search within
your results,
To visit Allume’s online support site, go to:
http://support.allume.com/
The new Support site also offers a public forum where you can post your
question and have it answered online by the Forum's resident experts and/
or Allume Support Specialists. Finally, if you still haven't found the
answer? After reviewing the pertinent FAQ's, you can submit a form to our
Support crew, which they will respond to by email. Support requests are
answered in the order they are received and response time varies depending
on the number of pending requests. Therefore we recommend checking the
FAQ’s and using the public forum.
When asking your question on the forum or submitting a Support request,
you will need to know the following information:
•

•

The exact version of the product you are using. This can be
found in the product About box (available in the Apple menu
when your StuffIt product is in the foreground of your screen).
Your registration number if applicable.
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•

The exact version of the Mac OS you are using. This can be
found by choosing "About this Mac" from the Apple menu in
the Finder on Mac OS X.

All other inquiries should be directed to the following address:
Allume Systems, Inc. 245 Westridge Drive,
Watsonville, CA 95076, USA
Tel.: 1+ (831) 761-6200
Fax: 1+ (831) 761-6206
Web: http://www.allume.com
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Chapter 2: Getting Started
StuffIt Expander :
The Basics

StuffIt Expander™ is used to expand the archived,
compressed, or encoded documents you receive from
others, over the network, on the Internet, or on a disk. When
you download files from the Internet, you'll find that they
are typically packaged in a StuffIt archive. Anytime you see
a file with “.sit” at the end of the file name, you're dealing
with a StuffIt archive that contains other files. The best way to understand
what an archive is, and why they are used so often, is to imagine that a file
posted on the Internet is just like an item you would send through the
regular mail. Just as you take precautions when sending a vase through the
mail, by carefully packaging it so that it won't get broken, so when you
send files to people over the Internet you should protect the file against
damage by placing it in a StuffIt archive. Plus, because putting a file in a
StuffIt archive makes it smaller, the file takes less time to transfer.

Expander is the application you use to open a .sit archive. The easiest way
to use StuffIt Expander is to “Drag and Drop” the file you want to open, on
top of the StuffIt Expander icon that was created on the desktop when you
installed the product. When you drag and drop the file on top of StuffIt
Expander, the application will launch, and expand the item inside the
archive. By default, the item in the archive will be created in the same
folder as the archive itself. For example, if you download a file from the
Internet to your desktop, and then drag and drop that file on top of StuffIt
Expander, the item inside the archive will also be placed on the desktop. If
the archive you are expanding contains multiple items, they will be placed
in a new folder that will be created in the same location as the archive you
are expanding.
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In addition to opening StuffIt Archives, you can use StuffIt Expander to
open just about any compressed or encoded file you encounter on the
Internet. Expander can open StuffIt, StuffIt X, Zip, and Tar archives, and
BinHex, MacBinary, Mime, and UU encoded files, and many, many more.
See “Supported Archive Formats” on page 62 in Chapter 11 for a list of all
supported file formats.
In addition to expanding all the files in an archive, you can also choose to
expand only the files you need. To expand individual files from a larger
archive you would use the StuffIt Deluxe application. See “How do I
Extract Files from an Archive?” on page 14 in Chapter 3 for more
information

DropStuff:
The Basics

DropStuff™ is the counter part to StuffIt Expander. Just as
you use StuffIt Expander to open compressed and encoded
files, so you use DropStuff to create archives from your
files and folders. You can use DropStuff to create archives
in StuffIt X (.sitx), StuffIt (.sit), Zip (.zip), and Tar (.tar)
formats.
Typically, you'll want to use DropStuff to compress your files whenever
you're posting them on the Internet, or whenever you're making backup
copies of your files. When you're sending files over the Internet,
compressing files to make them smaller means that it will take you less
time to upload the file, and it will also take the person receiving the file less
time to download and open it. Anyone on any type of computer can open
StuffIt archives, just point them to http://www.stuffit.com to download the
FREE StuffIt Expander software they'll need.
DropStuff works exactly like StuffIt Expander (see above), except that it
creates archives rather than expanding them. The easiest way to use
DropStuff is to drag and drop the files you want to compress on to the
DropStuff icon that was created on the Desktop during the installation. The
files and folders you dragged onto the icon will be compressed into a new
StuffIt archive. The archive will be created in the same location as the files
and folders you dropped onto DropStuff. For example, if you drag a folder
called “Pictures” from your documents folder onto DropStuff, you will find
a new file call “Pictures.sit” in your documents folder.
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By default, DropStuff is configured with settings that are best for everyday
use. DropStuff can be configured, however, to create archives for specific
purposes. The two options you'll likely want to use most often are SelfExtracting archives, and Encrypted archives.

DropStuff:
Self-Extracting
Archives

Self-Extracting archives are special types of StuffIt archives that can be
opened without StuffIt Expander. To open a self-extracting archive (.sea)
simply double click the file. To create a self-extracting archive you'll need
to open the DropStuff preferences dialog. To do so, choose Preferences
from the DropStuff menu in OSX, or Preferences from the Edit menu in
Mac OS 8.6 - 9.2.2.

Check the “Make self-extracting” check-box to tell DropStuff to make selfextracting archives, and use the toggle menu to specify the Operating
System on which the SEA will be used. Because self-extracting archives
use application code, they have to be made differently depending on the
Operating System on which they will be used. DropStuff allows you to
make self-extracting archives for the Mac OS and Windows. SelfExtracting archives for Mac OS will be created with “.sea” at the end of the
file name, and self-extracting archives for Windows will be created with
“.exe” at the end of the file name.
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Tip: Even though self-extracting archives for Windows (.exe) will
only self-extract on a PC, they can be opened on a Mac. To open a
Windows self-extracting archive on a Macintosh, drag and drop the
file on the StuffIt Expander icon. This type of file can therefore be
used when you’re not sure if the recipients are using a Mac or a PC.

DropStuff:
Encrypted
Archives

When you are sending sensitive files to other people, you can use
encryption to protect them with a password. This means that if someone
other than your intended recipient receives the archive that the files are
stored in, they will not be able to open it and gain access to your
documents. To tell DropStuff to protect your archives with encryption,
you'll need to open the Preferences dialog. To do so, choose Preferences
from the DropStuff menu in OSX, or Preferences from the Edit menu in
Classic version of the Mac OS.

Check the "Encrypt Archives with Password" check box (see above) to tell
DropStuff to add a password to your archives when they are created. When
you drag and drop files on DropStuff, you will be prompted to enter the
password you would like to use.
Warning: When you create an encrypted archive, be sure to make a
careful note of the password that you used. Allume Systems is not
able to recover the contents of an encrypted archive if the password
has been lost. There is no “Back Door”.

StuffIt
Contextual
Menu:
The Basics

The StuffIt Contextual Menu provides you with a way to access the power
of StuffIt Deluxe without having to launch any of the StuffIt applications. It
creates a special icon in the menu bar of the OS. To access the contextual
menu, hold down the Control (Ctrl) key while clicking a file. After you
install StuffIt Deluxe, you should see a new "StuffIt" Menu appear in the
contextual menu.

Compressing with
StuffIt CM

You can use the StuffIt Contextual Menu (or “CM”) to compress files into a
new StuffIt archives, and you can also use StuffIt CM to make archives in
other formats as well. To compress using the StuffIt contextual menu, hold
down the Control (Ctrl) key, and click the file you want to compress.
Choose “Stuff” from the StuffIt contextual menu to compress the selected
file or folder into a StuffIt archive.
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You can choose to
compress files and
folders using an archive
format other than StuffIt,
by using StuffIt CM’s
“Archive” sub-menu.
Under the Archive
submenu you will be able
to create Zip archives,
Tar archives, and Lha
archives. You will also
see various options here
that allow you to further
encode an archive you
have created.
You can also make selfextracting archives from
StuffIt contextual menu.
Select the file or folder you want to make into a self-extracting archive and
then choose either “Mac OS” or “Windows” from the “Make selfextracting” sub-menu.

Encoding with
StuffIt CM

The StuffIt Contextual Menu also allows you to encode files. Use encoding
when you want to post files to a News Group, or when you want to send
them via E-mail. You should also use encoding when you are posting a
Macintosh file that contains a resource fork (such as a Macintosh
application, or a self-extracting StuffIt archive) to a web site for other Mac
users to download. Typically, when you send files via E-mail, or upload
them to an FTP site for access over the Internet, you'll find that the
application you use to post or E-mail will encode the files for you.
To Encode files using the StuffIt contextual menu, Control (Ctrl) click the
file, and use the "StuffIt" menu to access the "Encode" sub menu.
Tip: You can only encode single files. If you need to post a folder
full of files, and need to use encoding, first compress the folder into
an archive, and then encode that archive. You can perform this task
in a single step, for example, by choosing Stuff and BinHex from the
Archive menu in the Magic Menu, or the StuffIt contextual menu.

Setting Options

To configure how the various options in the Magic Menu and the StuffIt
context menu work, choose Preferences from the StuffIt Context menu. For
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more information about changing settings using Menu Preferences, see “”
on page 76 in Chapter 10.

Stuff and Mail:
The Basics

The Magic Menu and the Contextual Menu also allow you to access one of
the most useful features of StuffIt Deluxe, Stuff and Mail. Stuff and Mail
allows you to compress a file or folder into a StuffIt archive, and then
automatically attach that folder to a new email message. To use Stuff and
Mail, select the file or folder you want to send, and then choose "Stuff and
Mail" from the Magic Menu. You can use the StuffIt contextual menu by
Control (Ctrl) clicking the file, and choosing "Stuff and Mail" from the
StuffIt menu.
By default, Stuff and Mail will use the Mail client that is currently set as
the default on your system. For a new Macintosh, this will be Outlook
Express for Mac OS Classic, and Mail for Mac OS X. You can, however,
change the mail client that Stuff and Mail uses with the Menu Preferences
application. Stuff and Mail supports Apple Mail, America Online, Claris
Emailer, Entourage, Eudora, Mailsmith, Outlook, Outlook Express,
Power- Mail, and QuickMail Pro.
After choosing Stuff and Mail, all you need to do is type the recipients Email address in the new message window, and click send.
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Chapter 3: The “How To...” Chapter
Overview

The information in this chapter is designed to help you get the most from
the StuffIt Deluxe package by providing “How To...” topics that cover
every day compression tasks. It assumes that you are already comfortable
with basic archiving tasks such as expanding archives and encoded files
with StuffIt Expander, and compressing files with DropStuff. If you need
information about these tasks, you can obtain more detailed information
about each of these applications by viewing their help files.
•
•
•
•
•
•
•
•
•
•
•

How do I create
an archive with
StuffIt Deluxe

How do I make an archive in the StuffIt Deluxe application?
How do I browse the contents of an archive?
How do I extract files from an existing archive?
How do I add files to an existing archive?
How do I search for files in an archive?
How do I segment files into smaller pieces?
How do I add a comment to an archive?
How do I add a password (encrypt) an archive?
How do I scan for viruses when expanding archives?
How do I encode files?
How do I create archives with error correction?

In addition to creating archives using DropStuff, the Magic Menu, and the
StuffIt Contextual Menu (as explained in the previous chapter), you can
also create archives using the StuffIt Deluxe application. When you create
an archive in the StuffIt Deluxe application, you first create a new empty
archive, and then add content. To create a new empty archive in the StuffIt
Deluxe application:
1. Launch StuffIt Deluxe
2. Click the “New” button on the StuffIt Deluxe toolbar
3. In the dialog that appears, choose a name and location for your
new archive. You can also use the “Archive Type” toggle menu
to select the format your new archive will use. You can create
StuffIt (.sit), Zip (.zip), or StuffIt X (.sitx) archives using the
StuffIt Deluxe application.
Once you have named and saved your new archive, a new empty archive
window will appear. You can add content to your new archive by dragging
and dropping files or folders from the Finder into the new archive.
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How Do I Browse
the contents of an
archive?

Often, when you receive an archive, you'll want to take a look at the files it
contains before you expand them. The StuffIt Deluxe application allows
you to do just that. When you open an archive with StuffIt Deluxe, rather
than StuffIt Expander, you will be able to browse through its contents in
much the same way you browse through the contents of a folder or a hard
drive. StuffIt Deluxe 7.0 allows you to open the contents of StuffIt archives
(.sit), StuffIt X archives (.sitx), Zip archives (.zip), and Tape Archives
(.tar), including those that have been compressed with Bzip2, Gzip, or
UNIX compression (.tbz2, .tgz, .tar.Z).
When you have StuffIt Deluxe installed on your system, you can open
StuffIt and Zip archives for browsing by double clicking them.
When you have an archive open in the StuffIt Deluxe application, its
contents will be organized by folder. When you see a folder in the StuffIt
Deluxe application, you'll notice that a disclosure triangle is displayed
beside it. You can see the contents of a folder inside an archive by clicking
the disclosure triangle. In this respect, the view inside of an archive works
in much the same way as "List" view in the Mac OS. You can also display
the contents of a folder in a new window by double clicking it.

When you view the contents of an archive in the StuffIt Deluxe application,
various information about the files it contains are displayed to you. In
much the same way as you would find information about a file in the
Finder using the Mac OS List view, StuffIt Deluxe uses a column based
view to provide you with information about the files in an archive. The
StuffIt Deluxe application has columns available for Kind, Label, Date
Modified, Size, Compressed Size, and percent Saved. You can sort the list
view that StuffIt Deluxe uses to display the contents of an archive, by
clicking any of the column headers. To reverse the sort order, click the
same column heading a second time. You can choose what columns are
used by StuffIt Deluxe in the Preferences dialog. You can also drag
columns around to reorder them just as you can in the Finder.
The window used by StuffIt Deluxe to display the contents of an archive
also displays additional information about the archive and the files it

Chapter 3: The “How To...” Chapter - 13

StuffIt Deluxe 9.0 Users Guide

contains. In the top right corner of the archive window, StuffIt Deluxe
calculates the size and compressed size of all the files in the archive, and
also provides an archive wide "percent saved" number.
If an archive contains items that have been encrypted with a password,
those items will be displayed with a key as part of their icon. You will need
to know the correct password in order to extract these items from an
archive.
The format of the current archive is displayed in the archive status bar.
Also in the Status bar are buttons that allow you to easily add edit or
remove Return Receipt requests and comments.

How do I Extract
Files from an
Archive?

The easiest way to extract a file from a StuffIt Deluxe archive is simply to
drag and drop the file you want to extract from the archive window to a
Finder window. After you've dropped the file to the desired location, a
progress bar will be displayed while StuffIt extracts the file from the
archive. You can extract multiple items using drag and drop by making
multiple selections in the archive window. You can click and drag within
the archive window to select multiple items that are next to each other in
the list. To select multiple items that are not next to each other in the list,
hold down the shift key while you are selecting files. When you have the
items you want to expand selected, drag and drop them to a Finder window.
You can also extract files from an archive by using the “UnStuff”
command. You can access the UnStuff command from the StuffIt Deluxe
Toolbar, from the Archive menu, and from the Context menu what appears
when you Control (Ctrl) click items in the archive Window. When you
extract using the UnStuff command, you will be prompted to select a
location to which files should be expanded.
Note: Files extracted from an archive are copies of the compressed
file in the archive. The compressed file remains in the archive
unless you choose to delete it.
If any of the items you are extracting have been encrypted with a password,
you will be prompted to enter the password before the items can be
extracted.
In addition to extracting files from an archive, you can also choose to
delete files from the archive. To delete, select the file you want to delete
and click the “Delete” button on the StuffIt Deluxe Toolbar.
In addition to allowing you to browse and extract files from an open
archive, the StuffIt Deluxe application also allows you to add files to an
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How do I Add
Files to an Existing Archive?

open archive. This feature is especially useful when you want to maintain
an archive with the latest versions of all your important documents.
The easiest way to add files to an archive open in StuffIt Deluxe is to drag
and drop them from a Finder window to the archive window. You can add
multiple items at once by making a multiple selection in the Finder and
dragging the files into the archive window. When you drop the files into the
archive, you will see a progress bar while the items are being compressed.
You can also add files to an archive using the "Stuff" command. The Stuff
command can be accessed from the StuffIt Deluxe Toolbar, from the
Archive menu, and from the context menu that appears when you Control
(ctrl) click items in the archive window. When you use the Stuff command,
you will be prompted to select the files to add to the archive in a Standard
file selection dialog.
If you have indicated that items should be encrypted with a password, you
will be prompted to enter the password before the items are compressed
into the archive.
In addition to adding files to a StuffIt archive, you can also rename, copy,
and move items that are stored in an archive. To rename an item, select a
file, and then click its name to activate the edit name text field. Click in the
text field to activate the cursor. To move a file, select the item you want to
move, and drag and drop it to its new location in the archive. To copy a file
in an archive, drag and drop while holding down the Option key. Again,
this works just like copying files in the Finder.
Note: StuffIt X (.sitx) archives can be created with redundancy. Creating archives with redundancy means that if they become damaged
due to transfer error or bad media, StuffIt can rebuild there contents. While you can open, browse, and extract files from a StuffIt X
archive created with redundancy in the StuffIt Deluxe application,
you cannot add new files, or other wise manipulate them.
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How Do I Search
for files in an
Archive?

The StuffIt Deluxe package includes an application called ArchiveSearch
that allows you to search for files located in archives in the same way that
you use Sherlock to search for files on your computer. You can launch
ArchiveSearch by choosing “Find” in the edit menu of the StuffIt Deluxe
application, or you can double click the ArchiveSearch application icon
which is located in the StuffIt Deluxe product folder.

When you launch ArchiveSearch, its default configuration will prompt you
to enter the name of the file you are looking for. When you enter the name,
and click Search, ArchiveSearch will look for a file that matches the name
you provided in StuffIt, StuffIt X, and Zip archives located on all available
local volumes.
When ArchiveSearch finds a matching item, the results window is
displayed. The results window displays a list of all matching items, when
you select a matching item the lower pane of the results window shows you
where the matching file can be found.
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When you Control (ctrl) click on a matching file, ArchiveSearch provides a
contextual menu that allows you to perform a variety of tasks.

•
•

•
•
•

•
•
•

Close window: Closes the results window.
Open Item: Extracts the selected item from the archive, and
opens it. For applications, this will result in the application file
launching, and for documents, the document will open in its
parent application (if it is available).
Reveal Item: Opens the archive that contains the selected item,
and highlights the file in the StuffIt Deluxe application.
Expand Item: Expands the selected item from the archive.
Expand to...: Expands the selected item from the archive. You
will be prompted to select a location to which the file should be
expanded.
Expand to Desktop: Expands the selected item from the
archive to the desktop folder.
Expand to Document folder: Expands the selected item from
the archive to the documents folder.
Copy Item Name: Copies the name of the selected item to the
clipboard.

If the matching item is encrypted with a password, you will have to enter
the password before you can open or expand it.
ArchiveSearch also provides many advanced search options that allow you
to refine the search. Click the "More Options" button to reveal the
additional options. Specify the advanced options in the ArchiveSearch
dialog in exactly the same way as you would for Sherlock searches on your
computer.

How Do I
Segment a File
into smaller
pieces?

StuffIt Deluxe allows you to create segmented archives. This feature is
useful if you need to split a large file into smaller pieces. Using the
Segment feature of StuffIt Deluxe you can take a large movie or sound file,
for example a 2Gb file, and split it up into smaller pieces so that you can
create a backup on CD-ROM. Segmenting is also useful if your E-mail
service limits the size of attachments you can send via E-mail. If your
E-mail service limits you to 1mb attachments, and you need to send a file
that compresses to 2mb, you can use the segment feature to split the file in
two, and attach it to two different E-mail messages.
The easiest way to segment a file is with DropStuff You can find the
DropStuff application in the StuffIt Drag and Drop folder in the StuffIt
Deluxe product folder. (Note that the segmentation feature of DropStuff is
only available when you are creating StuffIt X archives.) To turn on the
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segmenting feature, choose the size of segement you want to create from
the “Segmenting” popup menu. When you drag and drop files into the
DropStuff window, they will automatically be compressed into an archive,
and that archive will be created in pieces of the size you have specified.
The segments that are created will be named file.part01.sitx,
file.part02.sitx, etc. To expand these segments, simply drag and drop them
on top of StuffIt Expander. StuffIt Segments are cross platform compatible,
and they can be opened on a Windows computer using StuffIt Standard
Edition or StuffIt Deluxe.
You can also create segments using Magic Menu and the StuffIt Content
menu. To create a segment using the StuffIt contextual menu, Control (ctrl)
click the file you want to segment, and choose Segment from the Stuffit
menu. To segment using the Magic Menu, select the file you want to use,
and choose “Segment” from the Magic Menu. To select the segment sizes
choose Preferences from the StuffIt menu, or Magic Menu, and when the
Menu Preferences dialog is displayed, click the Segment icon from the
Preferences toolbar.

How Do I Add a
Comment to an
Archive?

Using the StuffIt Deluxe application, it is possible to add comments to
StuffIt, StuffIt X and Zip archives. Comments can be used for any number
of purposes, including providing information about the files the archive
contains, and instructions for their use. You can also use comments to
provide contact information so that the recipient can contact you if they
have questions.
To add a comment to your archive, you must first open the archive in the
StuffIt Deluxe application. When the archive is open, at the bottom left of
the archive window there are two pop-up buttons. One is used to add
Return Receipt requests, the other is used to add comments. Click the
comment button and choose "Edit". In the dialog that appears, type in your
comments. Click the "OK" button to add the comment to your archive. You
can also use the "Edit" dialog to change existing comments.

How Do I Create
an Encrypted
Archive?

StuffIt Deluxe allows you to protect your files by encrypting them with a
password as they are added to an archive. StuffIt Deluxe allows you to
create encrypted StuffIt, StuffIt X, and Zip archives using several different
methods.
Note: When you create archives with encrypting using StuffIt
Deluxe it is very important that you keep your password in a safe
place. If you loose your password you will not be able to expand the
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items in your archive. Allume is not able to recover the contents of
an encrypted archive if you have lost your password.
StuffIt Deluxe supports strong encryption. When you use either DropStuff,
StuffIt Deluxe, Magic Menu, or the StuffIt contextual menu to create an
encrypted StuffIt X archive, strong 512bit encryption will automatically be
used.
How Do I
Encrypt using
DropStuff?

Use the following steps to create an encrypted archive with DropStuff:
1. Launch DropStuff
2. Choose Preferences from the DropStuff menu (Mac OS X) or
from the Edit menu (Mac OS Classic).
3. Click the "Stuffing" icon.
4. Check the "Encrypt archives with password" box.
5. Click OK.
When you create archives with DropStuff when encryption is turned on,
you will be prompted to enter and confirm a password before you files are
compressed.

How Do I
Encrypt Using
the Magic Menu?

Use the following Steps to create an encrypted archive with Magic menu
and StuffIt contextual menu:
1. Choose Preferences from the Magic Menu (click the desktop if
the Magic Menu is not currently available)
2. Click the "Compression" icon.
3. Check the "Encrypt archives with password" box.
4. Click OK.
When you use the Magic Menu or the StuffIt contextual menu to create
Zip, StuffIt, or StuffIt X archives, you will be prompted to enter and
confirm a password.

How Do I
Encrypt Using
StuffIt Deluxe?

Use the following steps to create an encrypted archive with the StuffIt
Deluxe application:
1. Launch the StuffIt Deluxe application.
2. Choose Preferences from the StuffIt Deluxe menu (Mac OS X)
or from the Edit menu (Mac OS Classic).
3. Click the "Compression" icon.
4. Check the "Encrypt archives with a password" button.
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When you add items to an archive using either drag and drop or the Stuff
command, you will be prompted to enter and confirm a password.

How Do I Encode
Files?

StuffIt Deluxe allows you to create encoded files, in addition to creating
archives. Encoding typically means that a file is translated from a binary
(such as an application) into a text file. Encoding is typically used when
you are posting files to a News Group, FTP server, or sending files via Email. For most file transfers it is not necessary to encode the files yourself,
for example when you send files via E-mail your E-mail client will perform
any necessary encoding for you. Sometimes, however, you will run in to
situations where you need to encode the file yourself before uploading it.
Note: It is not necessary to encode a StuffIt or StuffIt X archive that will be
made available via either a web site or an FTP server. These archive types
include only a single data fork and will not be damaged if they are stored
on a Windows or Unix file system.
StuffIt allows you to encode in the following formats: BinHex (.hqx),
MacBinary (.bin), UUEncode (.uu), and Mime/Base 64 (.mm). You can
only encode a single file at a time. If you need to encode multiple items and
need them to be contained in a single file, you should first compress your
files into a StuffIt archive, and then apply the encoding.
To encode using one of the above formats:
1. Select the file you want to encode.
2. From the Magic Menu choose the Encode menu.
3. Select the encoding method you want to use.
You can also create encoded files from the StuffIt contextual menu. Control
(ctrl) click the file you want to encode, and choose the format you wish to
use from the StuffIt->Encoding menu.

How Do I Scan
for Viruses when
Expanding an
Archive?

StuffIt Expander includes a feature that allows you to automatically scan
files expanded from an archive with your Virus checking software.
Currently, StuffIt Expander supports scanning for viruses using Norton
AntiVirus, Virex, and Virus Barrier. You can choose another anti-virus
program by choosing “Other...” from the pop-up menu.
To scan files for viruses as they are expanded from an archive:
1. Launch StuffIt Expander.
2. Choose "Preferences" from the StuffIt Expander menu (Mac
OS X) or the Edit menu (Mac OS Classic).
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3. Click the "Expanding" icon.
4. Check the "Scan for Viruses using..." check box.
5. Use the toggle menu to select the virus program that you have
installed.
6. Click OK.
The next time you expand an archive using StuffIt Expander, your Virus
utility will automatically be launched and your files will be scanned as they
are expanded.

How Do I Create
an Archive with
Redundancy
(error correction)?

When you are creating archives in StuffIt X (.sitx) format, StuffIt Deluxe
allows you to create them with error correction. Archives created with error
correction are larger than those created without, but if they become
corrupted you are typically able to recover the contents. Error correction is
useful if you are sending particularly valuable files across the Internet, and
want to ensure that they will arrive intact. Using error correction can also
be useful if you are creating a backup of your files to removable media. If
that media becomes corrupted, you stand a better chance of recovering
your data if the archives are created with error correction.
Use the following method to create archives with error correction using
DropStuff
1. Launch the DropStuff application.
2. Choose Preferences from the DropStuff menu (in Mac OS X) or
the Edit menu (Mac OS Classic)
3. Click the Stuffing icon.
4. Choose “StuffIt X” as the archive type.
5. Check the “Add Error Correction” check box.
6. Click the OK button.
Archives that you create with DropStuff will now include error correction.
Use the following method to create archives with error correction using
Magic Menu or the StuffIt Context menu
1. Choose Preferences from the Magic Menu to open the Menu
Preferences dialog (click the desktop if Magic Menu is not currently available.
2. Click the StuffIt icon in the Preferences Toolbar.
3. Make sure the StuffIt Archive Toggle menu is set to "StuffIt X"
4. Check the "Add Error Correction" check box.
5. Click OK.
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Archives created with either Magic Menu or StuffIt contextual menu will
now include error correction.
Creating Error Correction archives with the StuffIt Deluxe application
You can add Error Correction to an archive that is currently open in the
StuffIt Deluxe application using the "Save a Copy as..." command in the
File Menu.
1.
2.
3.
4.

From the File menu choose "Save a Copy As..."
Make sure that the Format toggle menu is set to StuffIt X.
Click the Options button.
In the Options dialog, Make sure the Error Correction toggle
menu is set to On.
5. Click OK.
6. Choose a name and location for the new copy.
7. Click the Save button.
StuffIt Deluxe will now create a copy of the currently open archive with
Error Correction.
Note: Once redundancy has been added to a StuffIt X archive, it
effectively becomes “locked”; the addition of error correction
information to the archives means that no new files can be added,
and the existing files cannot be changed. If you need to edit the contents of a StuffIt X archive created with redundancy, use the “Save a
Copy As...” feature in StuffIt Deluxe to save a new copy of the
archive that does not include the error correction information.
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Chapter 4: The StuffIt Deluxe Application™
StuffIt Deluxe:
The Details

This chapter is designed to provide detailed information about the StuffIt
Deluxe application. It is the reference you should turn to if you have a
question about the function of a particular button, menu item, or
preference. If you are looking for information about how to do a particular
task, such as adding a file to an archive, please checkout the “How To...”
guide in chapter 5.

Using StuffIt
Deluxe

The StuffIt Deluxe application is the tool that allows you to browse and
manipulate the contents of your archives. The StuffIt Deluxe application is
able to browse and manipulate the contents of StuffIt (.sit), StuffIt X (.sit),
and Zip (.zip) archives. When StuffIt Deluxe is installed, you can open
your archives in the Deluxe application simply by double clicking them.
The StuffIt Deluxe application also allows you to browse the contents of
Tape Archives (.tar), including Tape Archives that have been compressed
using Unix Compress, Bzip, or Gzip compression. While you can browse
the contents of such files and extract individual items without expanding
the whole archive, the contents cannot be changed.
When an archive is open in the Deluxe application, its contents are
presented to you in much the same way as the Finder presents information
about the contents of a folder when it is in list view.

In addition to the standard information you would expect to see about a file
in a Finder view, such as its name, size, date of modification, and label,
StuffIt Deluxe also shows you the compressed size of the file and the
percentage saving gained through compression. You can change the sort
order of the list by clicking a column heading, clicking the same column
headings again reverses the sort order. You can choose what column
heading are displayed by opening the preferences dialog, and clicking the
Views icon.
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You can add and remove files from an archive using the StuffIt Deluxe
application in exactly the same way as you would add and remove files
from a folder in the Finder. Drag files into the window to add them to your
archive, and drag files from the archive window to the desktop to extract
them. You can also delete, rename, move, and copy files in an archive
exactly as you can in the Finder.
StuffIt Deluxe allows you to save a copy of the current archive using the
"Save a Copy As..." command in the File menu. Clicking the "Options"
button in the Save As dialog allows you change the compression level,
encrypt the archive with a password, make the archive self-extracting, and
add Error Correction (when saving the archive in StuffIt X archive).
For a more detailed “How To” that covers browsing the contents of an
archive, adding files, and removing files, See “Chapter 3: The “How To...”
Chapter” on page 12.

StuffIt Deluxe
Toolbar

Most of the features of the StuffIt Deluxe application, such as adding or
removing files from an archive, can be done by dragging and dropping in
exactly the same was as you would in the Finder. StuffIt Deluxe, however,
also provides a toolbar that allows the user to access the various functions
associated with manipulating the contents of an archive.

The following functions are accessible from the StuffIt Toolbar:
•

•

•

New Archive: The command will cause the StuffIt Deluxe
application to create a new empty archive. You can have up-to
nine archives open at the same time in the StuffIt Deluxe application.
Stuff: The Stuff command (also accessible from the Archive
menu) provides an alternative to drag and drop when it comes
to adding files to an existing archive. When the Stuff button is
clicked, a dialog prompts you to select the files that should be
added to the current archive.
UnStuff: The UnStuff command provides an alternative to drag
and drop when it comes to extracting files from a StuffIt
archive. The UnStuff button becomes active when an archive is
open and items are selected. When clicked, a dialog prompts the
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•
•

•

•

Setting Toolbar
Preferences

user to select a location to which the selected items should be
expanded.
New Folder: The New Folder button allows the user to create a
New folder in the current archive.
Delete: The Delete button is active when an archive is open and
items are selected. The selected items are deleted from the
archive when the button is clicked. The items are immediately
deleted, rather than being moved to the Mac OS trash can.
Get Info: The Get Info button is active when an archive is open
and items are selected. When used, an Info dialog is opened for
the selected item. This dialog functions in much the same way
as the Get Info dialog in the Finder. The dialog displays information about the size, and modification date of the file, and also
allows the user to view and edit its Type and Creator code.
Launch: The launch button allows you to UnStuff and launch
or open a file in a single step. This button is active when an
archive is open and items are selected.

The StuffIt Deluxe preferences dialog allows you to determine exactly how
the Toolbar will be displayed on the screen. You can edit the following
attributes:
•
•
•
•

Toolbar Orientation: This allows you to specify whether the
toolbar is aligned vertically or horizontally.
Toolbar Icon Size: Choose either large or small icons. Large
icon view is used in the example shown above.
Anchor Toolbar to top of screen: When checked, the StuffIt
Deluxe toolbar becomes fixed to the top of the screen.
Show Names: This setting determines whether or not the name
of each button will be displayed in addition to the icon.

StuffIt Deluxe
Menus

This topic provides information about the menus available in the StuffIt
Deluxe application.

The File Menu

The Following functions are available from the File menu in the StuffIt
Deluxe application.
•

Save a Copy As: StuffIt Deluxe allows you to save a copy of
the current archive using the “Save a Copy As...” command in
the File menu. Clicking the “Options” button in the Save As
dialog allows you change the compression level, encrypt the
archive with a password, make the archive self-extracting, and
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•

add Error Correction (when saving the archive in StuffIt X
format).
Verify: The verify command allows you to test the integrity of
StuffIt, StuffIt X, and Zip archives. If errors are encountered in
the archive, StuffIt Deluxe will prompt you to before attempting
to recover them.

The View Menu

The items available in the View menu allow you to change the sort order of
the list in the foremost archive window.

The Archive
Menu

The functions available in the Archive menu can be used to add and extract
files from an open archive, as well as to access advanced archiving features
such as comments or return receipt.
•

•

•

•
•

•

•

New: The command will cause the StuffIt Deluxe application to
create a new empty archive. You can have up-to nine archives
open at the same time in the StuffIt Deluxe application.
Stuff: The Stuff command (also accessible from the Archive
menu) provides an alternative to drag and drop when it comes
to adding files to an existing archive. When the Stuff menu item
is clicked, a dialog prompts you to select the files that should be
added to the current archive.
UnStuff: The UnStuff command provides an alternative to drag
and drop when it comes to extracting files from a StuffIt
archive. The UnStuff menu item becomes active when an
archive is open and items are selected. When clicked, a dialog
prompts the user to select a location to which the selected items
should be expanded.
New Folder: The New Folder menu item allows the user to create a New folder in the current archive.
Delete: The Delete menu item is active when an archive is open
and items are selected. The selected items are deleted from the
archive when the menu item is clicked. The items are immediately deleted, rather than being moved to the Mac OS trash can.
Get Info: The Get Info menu item is active when an archive is
open and items are selected. When used, an Info dialog is
opened for the selected item. This dialog functions in much the
same way as the Get Info dialog in the Finder. The dialog displays information about the size, and modification date of the
file, and also allows the user to view and edit its Type and Creator code.
Launch: The launch button allows you to UnStuff and launch
or open a file in a single step. This menu item is active when an
archive is open and items are selected.
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•
•

Edit Comment...: Opens the Edit Comment dialog that allows
you to edit or add an archive comment.
Return Receipt...: Allows you to add, edit or remove a Return
Receipt request.

The Translate
Menu

The Translate menu allows you to create archives in all the formats that are
supported by StuffIt Deluxe, but that cannot be directly browsed and
manipulated. These formats include LHa, Tar, Bzip, Gzip, Unix Compress,
Apple Single, BinHex, MacBinary, and UUEncode.

The Scripts Menu

The Scripts menu allows users to access the AppleScript features in StuffIt
Deluxe.
•
•
•

Adding a Return
Receipt Request

Open Script Editor: Launches Apple's Script Editor application.
Open Script Dictionary: Displays the AppleScript dictionary
for StuffIt Deluxe.
Open Scripts Folder: Opens the folder used to store StuffIt
Deluxe scripts.

StuffIt Deluxe allows you to add Return Receipt requests to your StuffIt
and StuffIt X archives. A Return Receipt request is used to ask the person
receiving your file to let you know that they were able to expand the
contents successfully. A Return Receipt Request includes your name, Email address, and a message to your recipient.
To add a Return Receipt Request to an archive that is open in the StuffIt
Deluxe application:
1. Choose “Return Receipt -> Add” from the Archive Menu.
2. When prompted to do so, enter your Name, E-mail Address,
and a message.
3. Click OK to add the Return Receipt request to your archive.
To edit an existing Return Receipt request:
1. Choose “Return Receipt -> Edit” from the Archive menu.
2. Modify the information in the Name, E-mail, and Comments
fields.
3. Click the OK button.
To Remove a Return Receipt Request:
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1. Choose “Return Receipt -> Remove” from the Archive menu.
2. Review the information, and click “Confirm”.

Responding to a
Return Receipt
Request

When you open an archive that contains a Return Receipt request, the
StuffIt Deluxe application will display a dialog providing information
about the Return Receipt.

When you see a Return Receipt request, the following options are
available:
•
•
•

•

Comments

Save: Saves the Return Receipt message as a text file so that
you can read it later.
Delete: Deletes the Return Receipt request from the archive.
Ignore: Dismisses the dialog. No action is taken. The Return
Receipt request will be displayed the next time you open or
expand the archive.
Respond: Creates a new E-mail message that is addressed to
the sender.

The StuffIt Deluxe application allows you to add comments to your
archives.
To add a comment to an archive open in the StuffIt Deluxe application:
1. Choose “Comment->Add Comment” from the Archive menu.
2. In the text entry field provided, add your comment.
To edit a comment:
1. Choose “Comment->Edit” from the Archive menu.
2. Edit the text in the comment field.
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The Get Info
Window

You can get information about any of the files in a StuffIt archive by
selecting the file, and clicking the Get Info button on the StuffIt Deluxe
toolbar.

In addition to information about the name, size, and dates of creation and
modification, the StuffIt Deluxe Get Info window also allows you to view
and edit the Type and Creator of the file.
Note: Type and Creator codes are used by the Mac OS to link documents to their creating applications. Only change the Type and
Creator codes for a file if you’re SURE you know what you’re
doing!
Just as you can assign comments to the archive as a whole, StuffIt Deluxe
also allows you to assign comments to individual files in the archive using
the Comments field in the Get Info window.
StuffIt Deluxe
Preferences

This topic is designed to provide information about the StuffIt Deluxe
preferences dialog. It covers the effect of all the available settings. The
StuffIt Deluxe preferences dialog is divided in pages, each page is
represented by an icon in a toolbar that runs across the top of the
application. To switch pages, simply click the icon that corresponds to the
page you want to view.

General Prefs

The General Page contains settings that effect the general operation of the
StuffIt Deluxe application.
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•

•

•

•

•

Compression

Allow Version Checking: The preferences governs whether the
StuffIt Deluxe application will check for updates when it is
launched. Using Version Checking requires that you have an
available Internet Connection.
Convert Old Archives on Open: When this check box is
checked, older StuffIt archives will be converted to StuffIt format. This setting applies to any StuffIt archive created by a version of StuffIt Deluxe prior to 5.0.
Number of Recent Items: This toggle menu allows you to
specify the number of archives that will be displayed in the
Recent Items menu item in the StuffIt Deluxe application.
Default Archive Name: This preference allows you to specify
the default name that will be given to a new archive created by
StuffIt Deluxe. The file extension for the currently selected file
format will be appended to the name you select.
Default Archive Type: This toggle menu allows you to determine the archive format that StuffIt will use when you select the
New Archive command. The StuffIt Deluxe application supports StuffIt, StuffIt X, and Zip archives.

The Settings in the Compression page are used to control how files are
compressed into archives.
•

Compression Level: As well as changing the format in which
the archive will be created, you can also change the
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•

•

•

•

compression level that will be used when items are added to the
archive. The choices are “Faster” and “Better”; as the names
suggest the “Faster” compression method makes archives more
quickly, and the “Better” compression method creates smaller
archives. An addition choice, “Custom” is also available. When
“Custom” is selected you can use the Advanced Compression
Preferences dialog to determine how StuffIt Deluxe will
compress your files. See “Chapter 9: Expert Compression
Settings” on page 55 for details.
Don't Compress Files that are Already Compressed: When
checked, this preference means that StuffIt will not attempt to
compress files that contain already compressed data when adding them to an archive. Examples of files that contain already
compressed data include .Gif and Jpeg images, MP3 music
files, as well as other archive file types.
Encrypt archives with a password: When this preference is
set, StuffIt Deluxe will encrypt items added to an archive with a
password.
Ignore Finder Desktop Files: When this preference is
selected, StuffIt Deluxe will not add Finder files (such as the
desktop database files) to an archive.
MacBinary: The preference determines how Macintosh files
that contain Resource forks will be treated when they are added
to Zip archives. As the Zip format does not support Mac
resource forks, they have to be MacBinary encoded to ensure
that they will be preserved. When the toggle menu is set to
Smart, files added to a Zip archive will only be MacBinary
encoded when StuffIt Deluxe detects that they contain a
resource fork.

Note: When you pick a MacBinary option, be aware of who will end
up using your files. If you use MacBinary encoding and send the
resulting Zip archive to a Windows user, they will most likely
encounter problems when trying to unzip the contents. By default,
we assume that you are zipping file because you want to send them
to Windows users, and therefore the MacBinary preference is set to
Never by default. The vast majority of Macintosh files are usable
without there resource forks, so even if Mac users open zip archives
created without MacBinary encoding, they should not encounter a
problem using the files contained.
Expansion Prefs

Expansion Destination: This preference determines where files will be
placed when they are expanded from an archive.
•

Same as Original: The file will be expanded to the same location as the archive file.
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•
•
•

Views Prefs

The Views page allows you determine what columns will be displayed in
the archive window.
•
•
•
•
•
•
•

Toolbar

Ask: You will be prompted to select a destination for the files
being expanded.
Use Specified: Use the Select button to specify a folder on your
hard drive to use every time you expand files from an archive.
Scan for Viruses Using: Using this preference, you can specify
that files extracted from an archive are scanned for viruses
using your Virus protection software. Use the toggle menu to
select your Virus program, Norton AntiVirus, Virex, and Virus
Barrier are supported.

Kind: Displays the Kind Column in the StuffIt Deluxe application.
Label: Displays the Label Column in the StuffIt Deluxe application.
Date: Displays the Date Column in the StuffIt Deluxe application.
Expanded Size: Displays the Expanded Size Column in the
StuffIt Deluxe application.
Compressed Size: Displays the Compressed Size Column in
the StuffIt Deluxe application.
Percent Saved: Displays the Percent Saved Column in the
StuffIt Deluxe application.
Show Invisible Files and Folders: Determines whether invisible files and folders located in your archives are displayed in
the archive window.

The Toolbars page allows you to configure how the StuffIt Deluxe toolbar
will look and behave.
•
•
•
•

Toolbar Orientation: This allows you to specify whether the
toolbar is aligned vertically or horizontally.
Toolbar Icon Size: Choose either large or small icons. Large
icon view is used in the example shown above.
Anchor Toolbar to top of screen: When checked, the StuffIt
Deluxe toolbar becomes fixed to the top of the screen.
Show Names: This setting determines whether or not the name
of each button will be displayed in addition to the icon.

StuffIt Deluxe allows you to work with the files inside an archive just as
easily as you can work with files inside of a folder. If you have a folder full
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Cool StuffIt
Deluxe Tips and
Tricks!

of files that you do not use regularly, consider compressing them into a
StuffIt archive. When you want to use one of the file, double click the
archive to open it in the StuffIt Deluxe application, and browse through the
folder to find the file you want to open. When you double click the file you
want to use, you will be prompted to save that file out from the archive
onto your hard drive. The file will then open in the application that created
it, and will be ready to use. If you make modifications to the file, simply
drag and drop it back into the archive.
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Chapter 5: ArchiveSearch™
Overview

Use ArchiveSearch to search for files located in StuffIt, Zip, and StuffIt X
archives in exactly the same way that you would use Sherlock to find files
on your computer. If you’ve used StuffIt Deluxe to create backups of your
important files, ArchiveSearch is an invaluable tool that makes it quick and
easy to search those backups to find a specific file.
For more information on the basics of using ArchiveSearch, be sure to read
“” on page 15.

Using
Archive Search

ArchiveSearch is designed to provide the “look and feel” of the Find File
section of Apple’s Sherlock application. You can search for files located in
an archive using ArchiveSearch, in exactly the same way that you would
search for files located on your hard drive using Sherlock.
When you first launch ArchiveSearch, the user Interface provides you with
options that allow you to look for files located in StuffIt, Zip, and StuffIt X
archives on any local hard drive using the name of the file you are looking
for. To start a search, simply enter the name of the file you want to find.

As with Searches conducted via Sherlock, the “Name Contains” need only
contain part of the name of the file you are looking for. For example, if the
file is called “StuffIt Deluxe” typing “Stuff” into the Name Contains field
will return StuffIt Deluxe as a matching result.
As with Sherlock you can specify that a search for files use additional
criteria to find a match.
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To add additional search criteria, click the More Choices button. Use the
Toggle menu to select the criteria you want to use. You may search using
all eight available criteria at once, or you can search using any combination
you choose.
The additional choices are as follows:
•
•

•

•

Name: Enter all or part of the name of the file you want to
search for.
Size: The size criteria can be used to search for files that are
less than, greater than, or the same size as a specified value.
When you select the size criteria, the second toggle menu in the
list is used to set how size will be defined, and the text entry
field is used to specify (in Kb) the size that will be used. The
size that ArchiveSearch looks for is the original size of the file
before it was compressed into the archive.
Compressed Size: The Compressed Size criteria is configured
in exactly the same way as the size criteria, except that
ArchiveSearch will look for the compressed size of the file
rather than the original expanded size.
Kind: Use the Kind field to specify the kind of file you are
looking for. You can specify the kind as alias, application, audio
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•
•

•

•

file, clipping file, control panel, document, extension, folder,
font, sound, stationary. You can also choose to find results
based on whether files match the specified kind or not.
Label: Use to find files based on whether they match (or don’t
match) the specified label.
Date Created: Use the Date Created criteria to match files
based on whether their date of creation is within the range specified. Use the date field at to specify a target date, and use the
toggle menu to specify whether matching files will be created,
on, before, or after the date you have specified. The toggle
menu also allows you to find files whose creation date is within,
a specified number of days, weeks, or months, from the date
specified.
Date Modified: The Date Modified criteria works in exactly
the same way as Date Created, except that Archive search will
look for files based on the modification date.
File Type: Use File Type to find matching files based on their
file type. File types are used under classic versions of the Mac
OS to distinguish between different types of documents created
by the same application, or to specify that a file is a specific
type such as an application, a control panel, or an extension.

As well as changing the terms of the search using file based criteria, you
can also specify the type of archives you want to search in, and the location
you want to search for archives.
Use the “Search For” toggle menu to specify the type of archives to search.
You can choose to search just for StuffIt archives, just for Zip archives, or
just for StuffIt X archives. The default is to search for files located in all
known archive types.
The location toggle menu allows you to limit the location that will be
searched. You can set the search location to be any of the following:
•

•
•
•
•

All Volumes: ArchiveSearch will search for files located in any
archive attached to any volume that is currently available. This
includes hard drives, network drives, CD ROMS and other
removable devices.
Local Unlocked Volumes: Use this choice to prevent
ArchiveSearch from looking in Network drives and CD ROMS.
Mounted Servers: Use this option to limit the search to just
mounted network volumes.
On the Desktop: Use this option to look for only files in
archives located on the desktop.
In the Finder selection: This option limits the search to only
folders or archives selected in the finder.
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•

•
•

Saving Search
Criteria

Open in StuffIt Deluxe: Use this option to search only in
archives that are currently open in the StuffIt Deluxe application.
In my Documents folder: Use this option to search for files in
archives located in your documents folder.
On a specific volume: ArchiveSearch also allows you to limit
the search to only archives located on a specific volume. A list
of all available volumes will be listed at the end of the location
list.

Once you have specified search criteria you can save it to a file that can be
used to set up a future search more quickly. To save you current search
criteria, choose “Save Search Criteria...” from the File menu.
To load a previously saved search, choose “Open Search Criteria...” from
the File menu, and select a saved search document when prompted to do
so.

The Archive
Search Progress
Window

Once you have established your search criteria, click the “Search” button to
begin searching for files. As ArchiveSearch is searching your hard drive, a
progress dialog keeps you informed of its progress. The following fields
are displayed;
•
•

•

Archives Found: This field indicates how many archives
ArchiveSearch has found in the specified search location.
Archives Searched: This field indicates how many of the
archives found have already been searched. This number, compared to the number of archives found, will provide a rough
indication of how much longer the search will last.
Items Found: Indicates the number of matching archives that
have been found.

You can stop the search at any time by clicking the “Stop” button.

The Archive
Search Results
Window

When ArchiveSearch finds a matching item, the results window is
displayed. The results window displays a list of all matching items, when
you select a matching item the lower pane of the results window shows you
where the matching file can be found.
When you Control (ctrl) click on a matching file, ArchiveSearch provides a
contextual menu that allows you to perform a variety of tasks.
•

Close window: Closes the results window.
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•

•
•
•

•
•
•

Open Item: Extracts the selected item from the archive, and
opens it. For applications, this will result in the application file
launching, and for documents, the document will open in its
parent application (if it is available).
Reveal Item: Opens the archive that contains the selected file
in the StuffIt Deluxe application.
Expand Item: Expands the selected item from the archive.
Expand to...: Expands the selected item from the archive. You
will be prompted to select a location to which the file should be
expanded.
Expand to Desktop: Expands the selected item from the
archive to the desktop folder.
Expand to Document folder: Expands the selected item from
the archive to the documents folder.
Copy Item Name: Copies the name of the selected item to the
clipboard.

You can also open any item in the results list by double clicking it. If you
double click an item located within an archive, that item will be expanded
and saved in the folder where the archive is located.

ArchiveSearch
Preferences

The ArchiveSearch preferences dialog allows you to specify the
destination to which files expanded from an archive should be saved.
•
•

Same as original: Files will be placed to the same folder as the
archive from which they are expanded.
Ask: ArchiveSearch will prompt you to specify a location to
which files are saved.
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•

Cool Archive
Search Tips and
Tricks!

Use Specified: Allows you to specify a single location to be
used whenever files are extracted from ArchiveSearch.

You can use ArchiveSearch directly from within the StuffIt Deluxe
applciation. Choose “Find” from the Edit menu to launch ArchiveSearch.
When ArchiveSearch has been launched via StuffIt Deluxe, you can choose
to limit your search to only those archives that are currently open in the
StuffIt Deluxe application.
You can also limit a search to particular archive, or folder, by dragging and
dropping the folder or archive onto the location toggle menu when
ArchiveSearch is running.
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Chapter 6: Archive Via Rename
About Archive
Via Rename

Archive Via Rename is a unique feature of StuffIt Deluxe that allows you
to compress files and folders into an archive simply by adding the file
extension of the archive to the end of the file or folder name.
For example, let’s say that there is a file called “Meeting Notes.txt” on my
desktop. Using Archive Via Rename, I can compress that file into a StuffIt
archive simply by adding “.sit” to the end of the file name. When the
rename has been completed, the file will be compressed into a StuffIt
archive called “Meeting Notes.txt.sit”.
You can also use Archive Via Rename to expand archives by removing the
archive extension from the end of the file name.
For example, let’s say that I have an archive called “Pictures.sit” on my
desktop. I can expand this archive simply by removing the “.sit” extension
from the end of the archive file name. Once the rename has been completed, StuffIt will expand the archive and place the expanded files in a
folder on your desktop.
Important Note!: Unlike other components of StuffIt Deluxe, Archive Via
Rename acts directly on the file or folder you are renaming. This means
that when you change the name of a file, such as “Meeting Notes.txt”, the
file you rename is REPLACED by the archive that is created. In the same
way, when you expand archives by renaming them, the archive you rename
is REPLACED by the expanded data.

Enabling Archive
Via Rename

By default, when you install StuffIt Deluxe, Archive Via Rename is turned
off. You can turn Archive Via Rename using the System Preferences dialog. To open the System Preferences dialog, choose “System Preferences”
from the Apple Menu.
To turn on Archive Via Rename, click the “StuffIt AVR” Preferences Panel,
and click the “Start” button. To stop Archive Via Rename, click the “Stop”
button in this same dialog.
In order to function correctly, Archive Via Rename requires that you configure Mac OS X to always display the extension of your files. If Mac OS
X is configured to hide extensions, Archive Via Rename will automatically
switch Mac OS X so that extensions are displayed.

Chapter 6: StuffIt Backup - 40

StuffIt Deluxe 9.0 Users Guide

Chapter 7: StuffIt Express™ Personal Edition
Overview

StuffIt Express is a utility that allows you to automate many
different file transfer and compression tasks. The StuffIt
Express application allows you to build custom “Express
Boxes” that automate a specific sequence of tasks; for
example you can use StuffIt Express to build an Express
Box that creates an archive, and then uploads that archive
to an FTP server.
To launch StuffIt Express, Open the StuffIt Deluxe application folder and
double click on the StuffIt Express icon.
Use StuffIt Express PE for the following tasks:
•
•
•
•

Creating a Drop
Box with StuffIt
Express

Compress and FTP in a single step
Distribute files to a range of recipients
Upload files to a web site
Automate common file compression and transfer tasks

StuffIt Express PE is an application program that you can use to create your
own personal drop boxes. A drop box is a special type of Macintosh
application that preforms specific tasks to files and folders that are dropped
onto its icon. These drop boxes can run any number of file compression
and transfer tasks. You can use these drop boxes to automate file transfer
tasks on your own computer, or you can create drop boxes to send to other
people so that they can easily send you files over the Internet.
Drop Boxes are created by adding tasks, or “Steps”, to a steps document in
the StuffIt Express PE application. A steps document is a sequential list of
all the actions that a drop box will perform. With-in Steps Document
interface, you can easily create steps, change the order of steps, and delete
steps as you create your drop box Each step contains all of the information
needed to accomplish that part of the task. For example, when you create a
step that will send a file by E-mail, you need to enter the E-mail address of
the person to whom the E-mail will be sent, and the subject and message
you want to send along with the file.
To add a step to an open steps document, you can either click the
corresponding button on the steps palette, or choose the step you want to
add from the New Step menu. To reorder steps, click and drag the step to its
new position with in the document. The “Details” pane provides you with a
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summary of all the information that corresponds to the selected step, you
can edit these details by double clicking the step from within the steps
document.
When all the Steps required to automate a particular task have been
specified, save the Steps document, and click the Create Drop Box button
in the toolbar. This will create a Drop Box that performs all the tasks you
have specified. Once a Drop Box has been configured, it can be modified
through the Steps document. To edit an Express Box, open its steps
document, make the necessary changes, and then click the Update Drop
Box button in the toolbar.

The StuffIt
Express User
Interface

The StuffIt Express User interface consists of the following elements:

The Steps
Document

The Steps document can best be described as a sequential list of all the
actions that an Express Box will perform. The buttons and menus that
appear around the Steps document are designed to make it easy for you to
add and remove steps from the list, build an Express Box application based
on the list, and update an existing Express Box by making changes to a
steps document.

•
•
•

•

•

Steps Document
Steps Palette
Actions Palette

Add Step Button: The Add Step button contains a list of all the
steps supported by StuffIt Express. Choose a step from the list
to add it to the steps document.
Drop Box Settings Button: Opens the Drop Box settings
dialog that allows you to change settings that govern how the
Drop Box will run. Click here to learn more about Drop Box
settings.
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•

•

•

•

•

Create Drop Box Button: This button is used to create an
Express Box application based on the steps document that is
currently open. If you have not saved the Steps document you
will be prompted to do so before the Express Box itself is
created.
Update Drop Box Button: This button is used to update an
existing Express Box application. To make changes to an
Express Box, you must open its steps document, make the
necessary changes, and then click the Update Drop Box Button
to update the Express Box application. If you have not already
saved your changes to the Steps document you will be prompted
to do so.
Run Drop Box Button: This button has the same effect as
clicking the Create Drop Box button, except that after the Drop
Box has been created it will automatically be run.
The Steps List: The Steps Document dialog contains a list of
all the steps that are currently specified. You can edit the details
of any of the steps by double clicking it. You can also reorder
steps within a steps document; click and hold down the mouse
button on the step you want to move until the insertion line
appears, and then drag the step to its new position in the list.
The Details Panel: Below the steps list is the Details panel.
This Panel is used to display information about the step that is
currently selected in the steps list.

The Steps Palette

The steps palette is divided into three tabs, one for File steps, one for
Internet steps, and one for Action steps. Each tab contains buttons that are
used to add a particular step to the Steps document. For example, the
Internet tab contains an FTP Upload button which is used to add an FTP
upload task to the steps document. For more information on the steps that
are available on each palette, please check out the appropriate section
below:

The Commands
Palette

The Commands palette is divided into two tabs. The Commands tab
contains buttons that are used to Create and Update Express Boxes. The
Wizards Tab contains links to templates that allow you to create Express
Boxes quickly and easily based on common tasks such as Zip and Send email.

Archive Step

Select "Archive" to add a step that archives files. "Archive" allows you
compress multiple files and folders together into a single compressed
archive file. You can specify what information is archived, where the
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resulting archive is created, a name, and the type of archive such as StuffIt
or Zip. See "What to act on" for details.
You can also choose to encrypt an archive to protect sensitive data, or
delete the archive after it is successfully created.

You can enter an Archive Name or leave this box blank to use a default
name. Choose an archive type. StuffIt X is the default. StuffIt files can be
expanded on Macintosh, and Windows using StuffIt Expander. Download
the latest version of StuffIt Expander at http://www.stuffit.com.
Additionally, you can choose a self-extracting file for Macintosh or
Windows.
Select "Encrypt archive with password" to protect sensitive data in an
archive. Write the password somewhere where you can find it later if
needed. You can also provide StuffIt with a default password to use when
the archive is created.
WARNING: If you forget an archive's password, there is no way to
recover the information or to modify the contents of the archive.
Allume Systems cannot decrypt archives without the password. Be
sure to remember your passwords or write them down and put them
in a safe and secure place. Note that passwords are case-sensitive.
Select "Archive originals instead of aliases" to ensure that the original
items are archived rather than their aliases. Select Segment, and choose a
size, to create an archive in multiple pices of the size you specify.
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Encode Step

Select Encode to add a step that encodes files. Typically you'll encode files
when sending them to a different type of computer or operating system.
You can specify what format to use and whether files inside folders should
be encoded. See "What to act on" and "Where to act" for details.
Choose an encoding type from the list. Next, if desired, select "Encode
files inside folders" to encode files contained within folders. Choose "Use
file name" if you are encoding only one file.

Expand Step

Select Expand to add a step that expands archives, placing the contents in
the location you specify. You can specify what is expanded, where the
resulting files are placed, whether files in folders are expanded, and which
files get deleted after expansion. See "What to act on" and "Where to act"
for details.
Choose one or more of these options as desired. Select "Expand files inside
folders" to expand the contents of folders contained in the archive. Choose
one of the "Passing expanded items..." options to specify what result is
passed to subsequent steps. This setting does not affect how the archive is
expanded, merely what information is passed to the next step in the drop
box. You can choose to pass both the folder structure and files to the next
step, or pass only the resulting files without their folders.

New Folder Step

Select New Folder to add a step that creates a new folder. You can specify
where the new folder is created and the folder name. You can also specify
to delete the folder when the drop box completes all of the tasks. See
"Where to act" for details.
Folder Name: Enter a name for the folder or use the default.

Copy Items Step

Select Copy Items to add a step that copies items. For example, you may
create an Express Box that copies items to another location as a back up.
You can specify which items to copy. See "What to act on" and "Where to
act" for details.
Select "Replace items with same names" to automatically replace items
with the same
names.

Move Items Step

Select Move Items to add a step that moves items. You can specify what is
moved, where the resulting files are placed, whether files in folders are
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replaced, and whether moved items are deleted once all of the drop box
tasks are complete. See "What to act on" and "Where to Act" for details.
Choose one or more of these options as desired. Select “Replace items with
same names” to automatically overwrite existing files with the same names
without prompting.

Open/Launch
Items Step

Select Open/Launch Items to add a step that opens or launches files. For
example, you can create a drop box that sends a group of images, then
launches an application to edit them. Or you can send a spreadsheet and
then open the application, assuming it is present on the system running the
drop box. To specify what items to open or launch, select an option from
the list. See "What to act on" for details.

Make Alias Step

Select Make Alias to add a step that creates an alias. For example, you can
create a drop box that opens an archive, expands a file, and puts an alias to
that file on the desktop. You can specify for what to create an alias, where
the alias is placed and whether the alias should be deleted when all of the
drop box tasks are completed. See “What to act on” and “Where to act” for
details.

Rename Items
Steps

Select Rename Items to add a step that renames files. You can specify what
items to rename. See "What to act on" for details.
Enter a new name only if you are renaming one item. Select "Keep existing
name's extension" to keep the current file's extension.

FTP Upload Step

FTP stands for file transport protocol and is a protocol used to send files to
or retrieve files from another computer on the internet. Select FTP Upload
to add a step that uploads files via FTP. You can specify what to upload and
the destination. You can also specify a user name and password. Be sure to
specify whether existing items should be replaced. See "What to act on"
for details on specifying what to upload.
FTP URL: Enter the URL of the FTP site.
Tip: To place a file into a directory, the URL must end with "/" otherwise, the address is assumed to specify a file or folder that should
be replaced. For example, if you specify www.allume.com/uploads/
the file would be placed into the uploads folder. However, if you
entered www.allume.com/uploads (and notice there is not a "/" at
the end) as the URL, the "uploads" folder would be replaced with
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the file you send. If you do not have rights to upload to a location,
you will receive an error message when you run the drop box.
If you are trying to replace existing items on a server, and file or folder
names (on your local disk and on the server) have special characters in
them such as the less than character (<), space, forward slash, colon,
percent, and any high-ASCII characters (greater than 255), you need to
encode those characters. To encode a character, use %xxx where x is hex
value of the character.
User Name and Password: Provide the user name and password if needed.
If you are logging onto an anonymous FTP site, you may need to enter
anonymous as your name and your e-mail address as your password.
Select “Replace existing items at this URL” to automatically overwrite
existing files with the same name. If you are uploading to a site with a
firewall, you may need to select “FTP Passive Mode” setting depending on
how the firewall is configured. Try sending with each of the options
selected. Contact the administrator of the ftp site if you are unsure.

FTP Download
Step

Select FTP Download to add a step that downloads files via ftp. You can
specify where to download files such as a downloads folder, or see "Where
to act" for descriptions of the other options.

FTP URL: Enter the URL of the ftp site. See "FTP Upload" above for
details on specifying the path and file name.
User Name and Password: Provide the user name and password if needed.
Select "Replace existing file or folder" if you want to automatically
overwrite existing files with the same name. If you are downloading from a
site with a firewall, you may need to select a "FTP Passive Mode" setting
depending on how the firewall is configured. Try sending with each of the
options selected. Contact the administrator of the ftp site if you are unsure.

HTTP Download
Step

Select HTTP Download to add a step that downloads files via http. You can
specify the download destination such as a downloads folder. See "Where
to act" for descriptions of the other options.
HTTP URL: Enter the URL of the http site. You can specify "http://" or
"https://" but be sure that the name specifies a file, and not a folder. There
should not be a "/" at the end of the line. See "FTP Upload" above for
details on specifying the path and file name.

Chapter 7: StuffIt Express - 47

StuffIt Deluxe 9.0 Users Guide

User Name and Password: Provide the user name and password if needed.
Select "Replace any existing file" if you want to automatically overwrite
existing files with the same name.

Open URL Step

Select Open URL to add a step that opens a specific URL in your web
browser. Enter the address of the URL to open. See "FTP Upload" above
for details on specifying the path and any special characters.

Send Email Step

Select Send E-mail to add a step that e-mails files. You can specify one or
more recipients, the subject and message text, and specify whether to send
immediately. StuffIt Express uses AppleScript to send E-mail using one of
the following E-mail clients: Mail.app (Mac OS X E-mail client), Eudora,
and Entourage. When the drop box runs, it will obtain the information it
needs from your e-mail client to send the message. Your computer must be
set up to use e-mail to use this feature.

What to E-mail: See "What to act on" for details. You can also choose
"Nothing" to create a message without an attachment.
Recipients: Click Add, then enter the name and address of each recipient.
In the Type box, specify To, CC, or BCC. "To" sends a message to a
recipient, CC or "carbon copy" sends a copy of the message listing the
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other recipients, and BCC stands for "blind carbon copy", and means to
copy the person without the other recipients seeing that person's name on
the list. To remove anyone on the list, select that name, then click Remove.
As you start typing an e-mail address, StuffIt Express tries to match the text
being typed to addresses that have previously been entered in this dialog
box. A floating window displays with most frequently-used matching
address highlighted; you can select that address by double-clicking the
address, or by pressing Enter. Select additional addresses the same way. As
you continue to type, StuffIt Express removes any addresses that no longer
match. When no addresses in the book match the address you have entered,
the address book window is removed.
Click "Recipients" to force the drop box to ask for recipients when the drop
box runs.
Message Settings: Enter a subject and an optional message. If you want the
name of the attachment to display in the subject, type "^A" to include the
name. In the message, type "^R" to display a list of most recent result items
or "^D" to display a list of all dropped items in the message. You can also
type "^" followed by a number to list the items resulting from a specific
step number in the steps document. Select the check boxes "Allow editing
of" to specify additional options. Choose "Subject and message" if you
want to be prompted for a subject and message each time you run the drop
box. You might choose this option if you have created a drop box that
allows you to quickly send messages to someone you frequently
correspond with. choose "Recipients" to edit the list when the drop box
runs rather than during creation. Choose "Substitute full path names" to use
the path to the original file. Choose "Include sender as recipient" if you
would like a copy of the message sent to the person using the drop box.
Select "Send Immediately" to send the message when the drop box is used.

Stop Drop Box
Step

Select Stop StuffIt Express to add a step that stops a drop box. For
example, if you provide a dialog box that asks if the user wants to continue,
and they choose No, use this step to quit the drop box. If they choose Yes,
you can skip one step (the Stop step) and continue running the drop box.
Message: Enter an optional message here that will display when this step is
encountered. If no message is specified, the drop box will stop and display
a dialog box.

Drop Box
Settings

Choose Edit > StuffIt Express Settings or click the StuffIt Express Settings
toolbar button to display the drop box settings dialog.
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•

•

•

Author and Description: The Author text is filled in with the
name entered when StuffIt Express was installed. You can
change this if needed. You can also add an optional description.
You may want to include the name of the drop box, how to
contact you, a version number, a description of what it does, or
other information indicative of its contents. The author and
description displays in the About box of the drop box you
create.
StuffIt Express E-mail Signatures: By default, a special
StuffIt Express signature is added to any e-mail message that is
sent from a StuffIt Express Drop Box. Uncheck this box to stop
this signature from being used.
Include DropBox in the StuffIt Contextual Menu: You can
make your StuffIt Express DropBoxes available in the StuffIt
Contextual menu, under the DropBoxes Submenu. When you
create a DropBox with this option set, an alias that points to it
will be created in the Library/Application Support/StuffIt CM
DropBoxes folder in your User folder. When you Control
[CTRL] click a file in the Finder, and choose a DropBox from
the DropBoxes menu, the DropBox will treat the selected file as
if it had been dragged and dropped onto the DropBox icon.

Tip: To remove a DropBox from the StuffIt Contextual menu, simple
open the Library/Application Support/StuffIt CM DropBoxes folder
in your User folder and delete the alias of the DropBox you wish to
remove.
Run Options: You can configure whether the drop box operates manually
or automatically. When one of the automatic options is chosen, the drop
box runs without user interaction once a file is dragged onto it.
•
•

Manual: The Steps window is visible, and the person using the
drop box must click "Start"
Automatic: The Steps window is only shown if an error occurs

Note: The steps window displays a list of the actions that the drop
box will perform. If the drop box encounters a problem, the resulting error message is displayed in the steps window.
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What to Act Upon
and Where to Act

There are a number of options that are common to most of the steps
available in StuffIt Express. These options allow you to specify the item a
step action is performed on and where any output is created.
•

What to act upon: "Dropped items" means the step will start
when items are dropped onto the drop box. "Most recent result"
uses the results of the last step that produced a file. "Ask for
items" displays a dialog box prompting for the files to be acted
upon. Once items have been selected, the step starts. "Result of
prior step" uses the results from a previous StuffIt Express step.
Note that this option is only available when a previous step
could result in files to act upon. Examples of what to act upon
include what to archive or what to upload.

•

Where to act: This specifies the destination folder for items
created using a drop box. "Same as original" means the same
location as the original item dropped on the drop box. "StuffIt
Express's folder" means the folder where the drop box is
located. "Ask" displays a dialog box that prompts for a
destination. "Result of New Folder step" is only enabled if a
previous step creates a new folder. "Special Folder" allows you
to specify an OS-related folder such as System. Choose
"Specific Folder" to specify that folder. Click the Choose Folder
button and navigate to the folder you want to use. If the
specified folder is not available, the person using the drop box
is prompted to specify a new location. Examples of where to act
include where to archive or where to download to.
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Chapter 8: StuffIt Plug-Ins
Overview

This version of StuffIt Deluxe includes Add-Ins for Adobe Photoshop,
Photoshop Elements, Illustrator, as well as Microsoft Word. The StuffIt
Add-Ins allows you to compress your word documents directly into StuffIt
archives, allows you to stuff and E-mail directly from within the Word
application, and allows you to open files directly from within StuffIt
archives.
The StuffIt Plug-In for Photoshop requires at least version 7.0 of
Photoshop, the Plug-In for Illustrator requires version at least version 10 of
Illustrator, and the Word Add-In requires at least word X.

Installing the
StuffIt Add-In for
Word X.

To install the StuffIt Add-In for word follow these steps;

Using the StuffIt
Word Add-In

When the StuffIt Add-In is loaded, four new options will be available in the
Word File menu;

1. Open the “Office Add-Ins” folder inside your StuffIt Deluxe install
folder.
2. Drag the file “StuffIt Word X Add-In” to the “Office\Startup\Word”
folder in your Microsoft Office X folder.
3. The next time you launch Word, the new StuffIt commands should be
available in your File menu.

•

•

•

Save as StuffIt Archive: This command will compress the
currently open Word document into a StuffIt archive. If the
document contains unsaved changes, you will first be prompted
to save those changes.
Stuff and Mail: The currently open Word document is
compressed into a StuffIt archive. That archive is then attached
to a new mail message created using your default E-mail
program.
Open Archived Document: This command allows you to open
a document from a StuffIt archive directly into the Word
application.

Note: This command assumes that the archive you are opening
contains only a single Word document. If the archive contains
multiple documents, the first Word document that is encountered
will be loaded.
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•

Installing the
Photoshop PlugIn.

StuffIt Preferences: Opens the StuffIt Menu preferences
application, from which you can change settings for the Word
Add-In.

To install the StuffIt Plug-In for Adobe Photoshop and Photoshop Elements, follow these steps:
1. Open the “StuffIt Third Party Plug-Ins” folder inside your StuffIt
Deluxe install folder.
2. Drag the file “StuffItPS” to the “Plug-Ins/Adobe Photoshop Only/
Automate” folder in your Adobe PhotoShop folder.
3. The next time you launch Photoshop, new StuffIt commands should be
available in the “Automate” menu in the File menu.

Using the
Photoshop PlugIn

When the StuffIt Plug-In is loaded, four new options will be available in
the Automate menu:
•

•

•

Save as StuffIt Archive: This command will compress the
currently open Photoshop document into a StuffIt archive. If the
document contains unsaved changes, you will first be prompted
to save those changes.
Stuff and Mail: The currently open document is compressed
into a StuffIt archive. That archive is then attached to a new
mail message created using your default E-mail program.
Open Archived Document: This command allows you to open
a document from a StuffIt archive directly into the Photoshop
application.

Note: This command assumes that the archive you are opening
contains only a single Photoshop document.
•

StuffIt Preferences: Opens the StuffIt Menu preferences
application, from which you can change settings for the
Photoshop Plug-in.

To install the StuffIt Plug-In for Adobe Illustrator, follow these steps:
1. Open the “StuffIt Third Party Plug-Ins” folder inside your StuffIt
Deluxe install folder.
2. Drag the file “StuffItAI” to the “Plug-Ins” folder in your Illustrator
folder.
3. The next time you launch Illustrator, new StuffIt commands should be
available in the “Automate” menu in the File menu.
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Using the
Illustrator PlugIn

When the StuffIt Plug-In is loaded, four new options will be available in
the Automate menu:
•

•

•

Save as StuffIt Archive: This command will compress the
currently open document into a StuffIt archive. If the document
contains unsaved changes, you will first be prompted to save
those changes.
Stuff and Mail: The currently open document is compressed
into a StuffIt archive. That archive is then attached to a new
mail message created using your default E-mail program.
Open Archived Document: This command allows you to open
a document from a StuffIt archive directly into the Illustrator
application.

Note: This command assumes that the archive you are opening
contains only a single Illustrator document.
•

Changing
Preferences

StuffIt Preferences: Opens the StuffIt Menu preferences
application, from which you can change settings for the
Illustrator Plug-in.

The StuffIt Plug-Ins share a common settings file with Magic Menu and the
StuffIt Contextual Menu. Settings made in the Menu Preferences application will also effect the Word, Photoshop, and Illustrator
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Chapter 9: Expert Compression Settings
Overview

The information in this chapter is designed to provide an overview of the
Expert Compression Settings dialog. This dialog provides an “Expert
Mode” interface for setting the way in which the various compression
methods supported by StuffIt Deluxe should be used. The dialog can be
accessed from any StuffIt application in which the compression level to be
used can be specified. When the Compression Level toggle menu is set to
“Custom”, the values in the Advanced Compression Settings Dialog will
be used.
The following formats support advanced compression settings:
•
•
•
•
•

StuffIt X
StuffIt
Zip
Bzip
Gzip

The Advanced Compression Settings dialog can be access from the
following applications:
•
•
•
•

StuffIt X Options:
Compression
Method

DropStuff
Magic Menu
StuffIt CM
StuffIt Deluxe

Compression method allows you to select different compressors for use
when adding files to a StuffIt X archive with compression.
•
•

•

Method 0 (No Compression): Files will be added to the
archive without being compressed.
Method 1 (Fastest Compression): Method 1 provides
compression that is optimized for speed of compression and
decompression. It works by replacing a series of bytes with a
reference to a previous occurrence of the same series of bytes.
Method 1 is used when the compression level is set to fast in
Menu Preferences, DropStuff, or StuffIt Deluxe.
Method 2 (Best Binary Compression): Method 2 is optimized
for the compression of binary files (such as applications) and
also for fast decompression. Method 2 works in the same way
as Method 1, except that it has a more exact way of representing
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•

•

•

•

StuffIt X Settings:
Levels and
Extents

the offsets and lengths, which makes it compress a little more,
but at the cost of slower compression and decompression.
Typically Method 2 will provide you with the best results when
you’re compressing applications.
Method 3 (Best Size/Speed Trade Off): Method 3 provides the
best trade off between compression/decompression speed and
archive file size and works well on a variety of different file
types. This compression method does a reversible sort on the
data, which places like data closer together which makes it
more compressible. Method 3 is used when the compression
level is set to Medium in Menu Preferences, DropStuff, or
StuffIt Deluxe.
Method 4 (Best text Compression): Method 4 provides
compression that is primarily optimized for text. This
compression method works by “predicting” what the next byte
will be based on previous data. For example, if it is predicting
the byte following “t” and “h”, it will give high probabilities to
“e”, and “a”.
Method 5 (Choose Method by File Type): This compression
method uses a combination of Method 3 and method 4 to
achieve better results. If the file being compressed is a mostly
text file, it uses method 4, otherwise it uses method 3.
Method 6 (Choose Method by Analysis): This method breaks
the file being compressed into bite size pieces and compresses
each piece with methods 2 through 4. Whichever method
produces the smallest output is used for that chunk of data. This
makes it very slow but it generally produces the smallest
possible files. Method 6 is used when the compression level is
set to Optimal in DropStuff.

Levels generally set “how hard” each method tries to compress.
In the matching algorithms (method 1 & 2), levels 1-9 generally correspond to Gzip's compression levels. The higher the number the harder it
tries to find a match (more compression, but slower). Levels above 9 use a
different, more exhaustive search for previous matches, which gets extra
compression, but at the expense of speed. In the “prediction” algorithm, the
level corresponds to how many previous bytes to use when making the prediction.
Note: Not all the compression methods used by StuffIt X support
setting compression levels. You cannot specify compression levels
for methods 3 or 5.
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Extents has a direct relationship to how much memory is used. In methods
1 & 2, the extent sets how far back to look for a match. In method 4, extent
sets how much memory to use for storing the prediction information.

StuffIt X Settings:
Text Encoding

StuffIt X archives can also be converted to ASCII text format. Three text
encoding methods are available, Base64 (-L 1), Base 88 (-L 2) and Base
222 (-L 3). The levels of available text encoding determine how much of
the full ACSII character set will be used to encode the data.The more characters used, the less size overhead will be imposed as a result of translating
the binary data of the archive into text characters. When sending archives
via E-mail, it is best to use Base64. This uses the fewest characters, but as a
result is the most compatible. Base 222 is a good choice if files are being
posted to a news group.

StuffIt X Settings:
Encryption

StuffIt X archives can be created with encryption. There are 4 compression
methods supported:
1=RC4 - Supports up to 512bit key lengths.
2=DES - Supports to 64bit key lengths
3=BlowFish - Supports up to 448bit key lengths
4=AES - Supports up to 256bit key lengths

StuffIt X Settings:
Redundancy

StuffIt X archives can be created with Error Correction. Adding error correction code to an archive will increase its size, but its availability allows
the engine to reconstruct data damaged as the result of bad media or transfer errors during the decode phase. You can vary the amount of error correction code applied to an archive during the encode phase, the range of
values supported are as follows:
•
•
•
•
•

StuffIt X Settings:
Optimizer

1/4 of a block ( 1% Overhead)
1/8 of a block (3% Overhead)
1/16 of a block (6% Overhead)
1/32 of a block (14% Overhead)
1/64 of a block (33% Overhead)

Optimizer are special compression methods designed to handle specific file
types. StuffIt Deluxe includes optimizer designed to compress Wave sound
files, Tiff graphics, and text files.
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StuffIt X Settings:
Block Mode

The Block Mode setting determines whether StuffIt will group files
together in order to compress them more efficiently.

StuffIt Settings

When creating StuffIt (.sit) archives you can choose between faster
compression or smaller archive file sizes. You can also choose to use no
compression at all when creating archives.

Zip Settings:
Compression
Method

When you create Zip archives you can choose between two different
compression methods, Deflate and Deflate 64. Typically, you will want to
use the Deflate compression method as it is most compatible with other zip
programs. Use Deflate 64 when you need to create zip archives that are
more than 2Gb is size.

Zip Settings:
Compression
Level

You can set the compression level for Zip compression between 1 and 15.
At level 1 compression will be very fast, but the archives will be larger. At
level 15 compression will be very slow, but the archives will be very small.
Changing the compression level has no effect on the compatibility of the
archive with other zip programs.

Lha Settings

Lha Supports just two compression levels, 0 and 1. Level 1 produces
smaller archives, but is slow than level 0.

Gzip Settings

You can set the compression level for Gzip compression between 1 and 15.
At level 1 compression will be very fast, but the archives will be larger. At
level 15 compression will be very slow, but the archives will be very small.

Bzip2 Settings

You can set the compression level for Bzip2 compression between 1 and 9.
At level 1 compression will be very fast, but the archives will be larger. At
level 9 compression will be very slow, but the archives will be very small.

UnixCompress
Settings

You can set the compression level for UnixCompress compression between
1 and 5. At level 1 compression will be very fast, but the archives will be
larger. At level 5 compression will be very slow, but the archives will be
very small.
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Chapter 10: The StuffIt X File Format
Overview

StuffIt X is a revolutionary new archive file format powered by Allume’s
exclusive StuffIt compression technology. The new StuffIt X file format
integrates compression with security and safety options to meet the
requirements of business and today's digital lifestyle.
StuffIt X is name of the new format, and StuffIt X archives have a file
extension of .sitx. You can use StuffIt X archives on any version of the Mac
OS from 8.6 to 9.x, and any version of Mac OS X 10.1 or later. You can
also use StuffIt X archives on Windows.
Whether you’re sending critical documents to business partners, or
vacation pictures to your family, StuffIt X is your best solution. In addition
to making the smallest possible archives, StuffIt X offers you strong 512bit
encryption to protect your files should they fall into the wrong hands, and
also features available error correction that helps to prevent data loss in the
event that your archives become corrupt as a result of transfer errors or bad
media.
StuffIt X archives cannot be expanded by older versions of StuffIt Deluxe
or StuffIt Expander. In order to expand a StuffIt X archive, your recipient
must have a copy of at least StuffIt Expander 7.0 installed. To make your
life easier, Allume provides StuffIt Expander for free to any Macintosh or
PC user. If you the StuffIt Deluxe CD, you’ll find a copy of StuffIt
Expander for Macintosh and Windows included. If you need a copy of
StuffIt Expander, visit our website: http://www.stuffit.com/expander

The value of
compression

The StuffIt X file format is designed to provide state of the industry
compression. When you create archives using the StuffIt X file format you
should expect to see upto a 20% improvement over the existing StuffIt
(.sit) format, and upto a 40% improvement over Zip (.zip).
Note: The amount of compression you will see will vary depending
on the type of data you are compressing. Typically text files compress the best, and files that contain already compressed data (such
as MP3 music files or JPEG pictures) will not be compressed as
well.
Even with Macintosh computers shipping with the minimum of a 10Gb
hard drive, compression still has an important role to play in the general
computing tasks that you perform everyday. Every time you download
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send a file to someone over the Internet, you can save time by first
compressing that file. The smaller the file, the more quickly it can be
transferred.

If you are hosting files for other people to download over the Internet the
size of the file you provide is especially important. Most Internet Providers
charge in such a way that the more kb of data users download from your
site, the more money it will cost you to host. Even if you being charged a
fixed fee to serve a small web site, your ISP has probably set a maximum
bandwidth allowance that limits the number of Megabytes of data that can
be downloaded from your site. Using StuffIt X to compress your files
allows you to maximize your bandwidth without having to increase your
cost.

The StuffIt X
advantage

While better compression is an important feature of the StuffIt X, what
makes the format a significant leap forward are all the enhanced file
security features that are also included.
•

Strong Encryption: The StuffIt X file format provides 512 bit
encryption to protect your sensitive data. This is a significant
improvement over the 40 bit encryption offered by the StuffIt
and Zip formats.

•

Error Recovery: Users looking to protect their files against
corruption can choose to create StuffIt X archives with error
recovery. If your archives become corrupted as a result of
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transfer errors or bad media, StuffIt can recover the missing
information.
•

Support for large archive size: StuffIt and Zip archives are
each subject to a file size limitation that prevents you from
creating an archive larger than 2Gb in size. The StuffIt X file
format has no such limitation, and will allow you to create
archives that are up to terabytes in size.

•

Support for long file names: StuffIt X archives

StuffIt X
Compression
Options

The StuffIt X file format provides you with many choices when you
compress your files. By default, when using Magic Menu, StuffIt
Contextual Menu, StuffIt Deluxe, or Drop Stuff, you can choose between
“Fast” or “Better” compression. One choice empathizes speed over archive
size, the other archive size over speed. You can also choose a “Custom”
compression setting that provides you with an increased level of control
over exactly how StuffIt X archives are created.

How to Create
StuffIt X archives

By default, StuffIt Deluxe is configured to use the older StuffIt (.sitx)
format when creating archives, but we’ve also made it easy for you to
change the compression method to StuffIt Deluxe.
•

•

•

DropStuff: Open the DropStuff preferences dialog and click
the Stuffing icon in the toolbar. From the Archive Type pop-up
menu choose “StuffIt X”.
Magic Menu and StuffIt Contextual Menu: Choose
Preferences from either the StuffIt Contextual menu or the
Magic Menu. Click the StuffIt icon in the toolbar, and choose
“StuffIt X” from the StuffIt archive Format pop-up menu.
StuffIt Deluxe: When you created a new archive using StuffIt
Deluxe choose “StuffIt X” from the Archive Type pop-up
menu.
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Chapter 11: StuffIt Reference
Overview

The StuffIt Reference chapter is intended to provide more detailed information about compression and archiving topics not directly connected to
the operation of any of the StuffIt Deluxe applications.

Supported
Archive Formats

The StuffIt Deluxe application is able to create archives in the following
formats:
•
•
•
•
•

StuffIt (.sit)
StuffIt X (.sitx)
Zip (.zip)
Tar (.tar)
Lha (.lzh)

Note: StuffIt Deluxe is able to expand and create encrypted Zip
archives, but does not currently support segmented or spanned Zip
archives.
StuffIt Deluxe able to expand, but not create, these additional archive file
formats:
•
•
•
•
•
•
•
•

Arj (.arj)
Arc (.arc)
Compact Pro (.cpt)
StuffIt 3.x archives (.sit)
StuffIt 1.5.1 archives (.sit)
Private File (.pf)
Rar (.rar)
CAB (.CAB)

Note: StuffIt Deluxe now supports expansion of RAR 3.0 archives.

Supported Compression Formats

StuffIt Deluxe is able to compress using the following “single file only”
formats
•
•
•

Gzip (.gzip)
Bzip (.bzip)
Unix Compress (.Z)
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Supported
Encoding Formats

StuffIt Deluxe is able to encode files using the following encoding methods:
•
•
•
•

MacBinary (.bin)
UUEncode (.uu)
BinHex (.hqx)
AppleSingle (.as)

StuffIt Deluxe is able to expand, but not create, the following encoding formats:
•
•

File Compression
Explained!

MIME/Base 64 (.mm, .mme, .b64)
yEncode (.yenc)

Compression works by eliminating or minimizing redundancy in a file,
making your files smaller without losing any information. Every character
on your computer, every letter, digit and punctuation mark, is actually
made up of several characters that make up computer code. A simple
example of compression is: If you have a set of characters "AAAADDDDDDD" representing a letter, one type of compression software can
rewrite this as "4A7D", saving seven spaces and making that line 64%
smaller. Compression software uses algorithms to do this.

Chapter 11: StuffIt Reference - 63

